STEM

for xHREM®
(WinHREM?® /MacHREM?® )

Scanning
Transmission Electron Microscope  Image
Simulation Program




STEM for xHREM

Scanning Transmission Electron Microscope
Image Simulation Program

User's Guide

Contents
m Introduction
m |nstallation
m Let's Start Tutorials
Data Preparation
Dynamical Scattering Calculation
Gray-scale STEM Images Display
B Topics
TDS Absorption
Required RAM Size

STEM 2



STEM for xHREM

m |[ntroduction

This is a program to simulate a scanning transmission electron microscope
(STEM) image. This prograns designed as an optional function of
xHREM?2 (WinHREM?2 /MacHREM? ), a program suite simulating a
high-resolution electron microscope image for Windows/Mac OS.

XHREM? has the following features.

Concept of xHREM™

User Friendly Graphical Interface

XHREM & employs user friendly Data Generation Utiktibased on the
Graphical User Interface for Windows or Mac OS.

XHREM & is generalpurpose software that can be used to simulate all the
images expected from any crystal systems, defect structures and interfaces.
Although data generation for such gengraipose software normally
becomes complex, a novice user can easily generate his/her data by using
the graphical Data Generation Utilities with minimum requirements for the
special knowledge.

2. Reliable and Efficient Algorithm

XHREM & emerges from the HREM irga simulation programs based on
FFT multislice technique developed at Arizona State University, USA (see
References). This is one of the most reliable and efficient HREM image
simulation programs

3. High Quality Image Output
Numerical data such as projedtpotential, wave function propagating the
specimen, simulated image intensities could printed as high quality gray
scale maps (Bitmap) by using Output Graphic Utilities. Numerical value
of each pixel of the gray scale can be exported for further anailyis
other software.

Concept of STEM Extension

User Friendly Graphical Interface

STEM Extension employs user friendly Data Generation Utilities based on
the Graphical User Interface for Windows or Mac OS.
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2. Reliable and Efficient Algorithm

Thermal Diffuse Scattering (TDS) is believed to be the main source of
signal for STEMHAADF image. STEM Extension will efficiently treat
TDS using absorption potentialBlease consult the following paper for a
detailed description:

K. Ishizuka: A practical approachrf&@TEM image simulation based on the FFT
multislice method, Ultramicroscopy 90 (2001)-83.

3. Efficient Computation (Multi-CPU Support)
STEM image simulation is number crunching, since scattering calculation is
necessary at each scanning point. TherefSFEEM Extension supports
multi-CPU (Core) to accelerate computation.

Note: From the next version(v3.6) the following two STEM Extension
will be newly released STEM Extension Clustefa cluster support) and
STEM Extension Pr¢64-bit OS support).
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m |[nstallation

STEM program&nd some sample data should be already installed into your
hard disk, when you have installed xHREM Simulation Suite.

When you purchase STEM program as an additional order, you have to
update your user key. This update can be dmynaisingRemote Update
System (RUS). When you send current key information, then we will send
back information to update your key.
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m Let's Start Tutorials

Data Preparation

Most of the data for scattering calculation control will be prepared by using
"MultiGUI". A set of data specific to the STEM simulation will be specified
in the optional windows. Please consthREM User's Manual about the
general scattering calculation controls.

A sample data for SnO2 will be provided with the program.

In order toset up the optional data specific to the STEM simulation, click
"STEM" from the Options at the bottom of the MultiGUI WORKSHEET.

Options

(o) (vemves)

Then, the following window will open:

Wit STEM Parameters Q‘E|®

1 _> Optical Parameters

Aperture radius: i0~5 /Bngstrom
Third order Cs: i1 0 mm
Defocus: :5000 Angstrom
Fifth order Gs: (00 | mm
Detector Parameters
2P Bright Field: 0. | /anestrom
Dark Field Inner: :0-5 /Angstrom
Outer: j1 0 /Angstrom
Scan Contral
3 _> Scan Mode: jF\rea v:
X: |00 | <> 10 | £ 11 | Points
v:00 <> [0 | /1T |Paints
Data Qutput Every »1 Slices
List Qutput: :X. Y position / slice v:

[ ok | [ Cancel ]
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Heel STEM Parameters E“E]@

Basic
4 _> Optional Optical Parameters
a1 o1z |0 nm |0 dee.
{Coma) C21: 0 nm |0 deg.
(A2 c23: |0 nm |0 dee.
c32: |0 am |0 dee.
(A3) C34: 0 am |0 deg.
C41: |0 mm |0 dee.
C43: 0 mm 0 deg.
(A4) C45: |0 mm |0 dee.
C52: 0 mm 0 deg.
C54: 0 mm 0 dee.
{(#5) CB6: |0 mm |0 dee.
Wave aberration : Cnm/(n+ )
5-> Super-czll Size: | Standard v
[ oKk | [ Cancel |

Optical Parameters

Input an aperture radius, aberration coefficients. e &perture radius
may be given in mrad (You have to select mrad in the Preferences
before open this window.)

Detector Parameters

Detector radiuses of the brigfield imaging and the darkeld imaging
will be specified here. These radii may be givemnad (You have to
select mrad in the Preferences before open this window.)

Scan Control

Scan Mode: Scanning scheme will be selected from the list shown
below.

Whale Unit
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Position: Scanning position(s) will be specified here. The scanning
positions will be specifd in different ways according to the
scanning mode.

Area: The ranges of the scanning area and numbers of scanning
points along x and y will be specified for this mode.

Line: The starting position and the ending position as well as the
number of scanningoints will be specified for this mode.

Point: A single position will be specified for this mode.

Whole Unit: The whole unit area will be calculated assuming an
applicable symmetry. Thus, the tamensional symmetry
group and an approximate scanning stieyperval) will be
specified. Integral number of scanning points will be
calculated internally according to the approximate sampling
interval.

Scan Control
Scan Mode: Whole Unit v
Symmetry: | pl v

Calculation step: 0.2 fngstrom

Data Output Cycle: STEM image intensityputput interval in terms of the
slices.

List Output: the list output showing a scan progress. When a computing time
for each slice is very quick, the scan list output may control the overall
turnaround time. In this case, a simpler lit output is effective to shorten
the turnaround time.

.................................................................

}{ Y position
Y position

4.  High Order Aberration Coefficients

High order geometrical aberration coefficients up to 5th order can be
specified here. Although various definitions of the coefficients appear
in the literatures, we simply define them in terms of wave aberration as

Cnm (n+1)

—a cosm(¢ — .

o (¢~ fum)
5.  Super-cell Size

Supercell size used in computation will be selected from the following
pull-down list. Normally, OStandardO can be selected here:
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Test
amall

] )
Large
Huge
Ultimate

The supercell size in computatioshould be larger than the input
structure model. If the structure mode is smaller tharsupecell size,
the input model is repeated to fill the supetl. Thus, the model size in
computation is a multiple of the input model.

Supercell size and sampling*

N Model Modellsize Sampling FT space interve
(Approximate)  points* (Approximate)

1 Test 125 A 128 0.08/A

2 Small 25 256 0.04

3 | Standard 50 512 0.02

4 Large 100 1024 0.01

5 Huge 200 2048 0.005

6 | Ultimate 400 4096 0.0025

*The number of the sampling points shown here is estimated for a
rectangular unit cell assuming tRange(a limit of calculation in
Fourier space) of 5.0/A (in d*). An approximate number of the
sampling points is given by 2Range/(sampling interval).

TIPS: The limit of calculation inFourier spacewill be specified by
ORangeO parameter at Preferences/Dyalacalculation The numbers

of the sampling poinwill increase proportionally with thémit of
calculation inFourier spacek-or an oblique system the required number
of pixels becomes larger than these number shown here.

TIPS: Normally, the Range 05.0/A is enough for calculation using
HAADF TDS absorption potentials.

TiPs: For STEM image calculation it is not necessary to evaluate
scattering profile. Thus, the supezll less thanCstandar® is not
recommended to be used.

NOTE STEM simulation will use a large number of the samplin
points. Therefore, you will get a huge amount of the li
output, when you try to print out the whole area of the
potential distribution or the scattering distribution.
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Dynamical Scattering Calculation

1.

Create the general scattering calculation controls in the main WORKSHEET.

TIPS: To calculate elastic scattering to highgle, a calculation range
of s=1.52.0/A (d*=3.04.0/A) or higher will be set byreferences>
Dynamical calculatior> Range However, Doyle-TurnelO cannot be
used above £0/A. You have to selectV@eikenmeierKohlO foa a
calculation over s2.0/A.

TIPS: Choose OWeikenmeikohl Scattering FactorO from
Preferences/Atomic Scattering factor, and check Olncluding TDS
AbsorptionO box. However, when yoamw to ignore TDS absorption,

and obtain a STEM image using only elastic scattering, you donOt need
to check this box. Please note that includifiS absorption requires

a thermal factor (DebyeWaller factor) of each atom

Set up the optional data for STEM simulation.

Launch STEM program by choosing "Execute STEM" from the File menu of
the MultiGUI.

A window showing the progress of the calculation appears.

When an execution terminates normally, you will get the message
"Execution completed. Congratulatid

TIPS: Calculation of a STEM image by scanning many points will take
a long time. Thus, you can stop calculation and continue it layer. In
order to resume calculation, choose OAppendO from MultiSUI
Multislice Calculation. When you stop calculatian,calculation will
resume from the following scan poioh which a full propagation has
been completed.

You can save the result window by choosing "Save As..." from the File menu
of the result window.
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Gray scale STEM imagesilWwbe generated by using the "STEMimage"
utility. The STEM data has been output to a .SD file.

To display a gray scale STEM image, do this:
1. Launch STEMimage.

2. Select a".SD" file with your sample name in the file selection dialog.
(Windows) When you ganot find your SD file, confirm that the file
type specification is "SD Data (*.SD)."

The following window will be appeared.
Wil GaAs011s.SD - xStemImaee
File Edit Window Help

Title: Gafs 011]

Unit Cell a:4.000 b : 5650 angle : 0.00

Scan Contral: Whale Unit a 0000 <=> 0500 5 points

b: 0000 <-> 0500 f 7 points
Cisplay Control
Digplay Mode: STEM Imaee v | (24 Pixels/Angstrom
Display Ranee: slice: |2 S

a (00 <=> 20 {193 pixels)
b: (0.0 <-> |20 ( 272 pixels)

Image Mode

() Bright Field (%) Dark Field [¥]TDS  [¥]Coherent

BF Aperture: 0474 DF Aperture : 2233  <-> 4000
Cisplay Limit
Low: Minimum I:] reverse contrast
High: Maximum
Generate
3. Select "Display Mode"

Select a display mode from "STEM Image"”, "Thickness Map" and

"Point."

Selectable display mode is depegddn the Scan Mode.

As in this case of a twdimensional scan image, you have to select the

specimen thickness (slice number), a display area and a resolution
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(Pixels/length).

When the Scan Mode is "Whole Unit," you can extend the display area
more tharone unit cell.

4. From "Image Mode" you can select the image type from "Bright Field" or "Dark
Field." In the case of the dark field image, you cal also select the image
signal(s) from TDS inelastic signal and/or coherent elastic signal.

5. Click "Generate" to display a gray scale image.

TIPS Each pixel value of a gray scale map produced by STEMimage can be

output using OSave AsEO command as you can do by using ImageBMP.
The original data used to produce the gray scale map can also be output
using OSave AsE@ommand. Please consulN@nerical Data Output
Using ImageBMP® the xHREM manuafor more details.
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B Topics

In this section some useful functions as well as advanced topics will be
introduced. It is not necessary to read through all the topics at the first time.
You may want to study each topic when you need to use it.

Including TDS Absorption

You caninclude absorption of elasticallgcatteredwave due to thermal
diffuse <attering (TDS) in your dynamical calculation. In this case,
however, thermal displacement parameter {emperature factor;
DebyeWaller factor) for each atom in your atomic model is required
When you dof® know acorrespondingparameter, an approximate value
may be specified.

To include TDS absorption in your dynamical caldolat
}  Launch MultiGUI
} Choose “Preferences” from Edit menu.

} Select “Weikenmeier-Kohl Scattering Factor” in “Atomic Scattering Factor”
section of the Preferences dialog, and check “Include TDS absorption.”

Atomic Scattering Factor

() Mott Formula with Doyle-Turner X-ray Scattering Factor
(%) Weikenmeier-Koh| Scattering Factor [V]Ihcluding TDS Absorption
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Required RAM Size

For STEM image simulationscatering calculation is necessary at each
scanning pointThen we have to use all the phase gratifmseach scan
point. A cotemporary operating system (OS) allows usige many phase
gratings by uig a virtual memory management.

However, when a main memyois short to store only a singphase grating,

all the phase gratings should be read from an external memory as a result of
roll-in/roll-out. If an external memory is a hard disk, a significant time is
required to read the phase gratings into the ma&many. Thereforeall the

phase gratings should be stored in the main menforyan efficient
computation.

Typically, each program can useroughly 2GB using a 238it OS. If the
total phase gratings ibigger than this size, you have to USTEM
Extensia Pro that supports a @it OS.

TIPS: In the case of a Standard model with 512x612 pixels, each phase
grating requires the following memory:

(512x512) x 8 (complex) x 2 = 4MB

A larger model uses more phase gratings of larger size, so the total phase
graings will become more than B>
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